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Lampiran 1. Lembar Observasi  



LAMPIRAN 1                                                                                                                                                                           

                                                       
Universitas Negeri Yogyakarta 

 

 

FORMAT OBSERVASI 
PEMBELAJARAN DI KELAS DAN  

OBSERVASI PESERTA DIDIK  

NAMA MAHASISWA   
NO. MAHASISWA  
TGL. OBSERVASI   

: 
: 
:  

MAWAR RAMADHANI   
08520241028  
16 Februari 2012 

PUKUL  
TEMPAT PRAKTIK  
 
 
 
FAK/JUR/PRODI  

: 
: 
 
 
 
:  

10.00 – 12.00  
LABORATORIUM 
KOMPUTER SMA N 1 
KALASAN  
(KELAS XC)   
FT/PT. ELKA/PT. 
INFORMATIKA   

 
No Aspek yang diamati Deskripsi Hasil Pengamatan 

A Perangkat Pembelajaran   

1. Kurikulum Tingkat 
Satuan Pembelajaran 
(KTSP)  

Menggunakan Kurikulum Tingkat Satuan Pendidikan yang 
mengacu pada MGMP TIK Kabupaten Sleman, namun pada 
praktek penerapannya disesuaikan dengan kondisi sekolah.  

2. Silabus  Mengacu pada Kurikulum Departemen Pendidikan Kabupaten 
Sleman.  

3. Rencana Pelaksanaan 
Pembelajaran (RPP)  

Mengacu pada Silabus pada poin 2.  

B Proses Pembelajaran   

1. Membuka pelajaran  Dibuka dengan salam dan langsung melakukan presensi siswa 
(dipanggil satu per satu). Setelah itu guru me-review materi 
minggu lalu kepada siswa.  

2. Penyajian materi  Menggunakan LCD & layar, contoh ditampilkan pada layar. 
Melalui media viewer, guru menyajikan materi dengan 
menjelaskan tahap demi tahap.  

3. Metode pembelajaran  Ceramah dan praktek langsung. Guru menyampaikan konsep 
materi sedikit di awal dengan perumpamaan-perumpamaan dan 
model manual.  

4. Penggunaan bahasa  Indonesia-Jawa, disertai guyonan.  
 

5. Penggunaan waktu  Dijelaskan konsep materi beberapa menit di awal, dan beberapa 
menit kemudian memberikan contoh praktek, kemudian siswa 
diberi kesempatan untuk mencoba mempraktekkan. 

.  

6. Gerak  Gerak guru : leluasa, flexible, berulang kali kontrol komputer, dan 
aktivitas guru dipermudah dengan adanya pengelola lab yang 
membantu jalannya proses KBM dalam penggunaan komputer.  
 

7. Cara memotivasi siswa  - Memberikan tugas kemudian dinilai sebagai feedback 
nya 

- Guru keliling kelas untuk menilai tugas siswa. 
- Setelah ada siswa yang dapat menyelesaikan tugas 1, 

guru segera memberikan tugas 2. 
 

8. Teknik bertanya  Guru menanyakan kepada seluruh siswa mengenai cara 
membuat animasi yang baik. Teknik ini digunakan sebagai 
feedback mengenai aktivitas siswa.  
Untuk siswa sendiri, memungkinkan untuk bertanya sewaktu-
waktu dan tidak terbatas. Antar teman pun sangat 
memungkinkan untuk saling mengajari penyelesaian masalah.  
Siswa dengan bebas bergerak tanpa ada kontrol dari guru,  



LAMPIRAN 1                                                                                                                                                                           

                                                       
Universitas Negeri Yogyakarta 

 

 

FORMAT OBSERVASI 
PEMBELAJARAN DI KELAS DAN  

OBSERVASI PESERTA DIDIK  

9. Teknik penguasaan 
kelas  

Guru menjelaskan dengan media viewer dan menjelaskan 
dengan suara yang dapat didengar oleh seluruh kelas. Sesekali 
guru mengucapkan kalimat ’coba perhatikan’ ketika suasana 
kelas kurang kondusif untuk menjelaskan.  

10. Penggunaan media  Dimaksimalkan dengan LCD dan layar sehingga tugas bisa 
diperagakan di layar sepanjang waktu.  
Jumlah komputer yang memadai kurang dari jumlah siswa, 
sehingga menyebabkan siswa jalan-jalan dan terkesan ricuh. 

11. Bentuk dan cara 
evaluasi  

Menjelaskan langsung kepada siswa yang kurang jelas (belum 
bisa menyelesaikan tugas). 
Guru berkeliling kelas untuk melihat hasil pekerjaan siswa dan 
mencatat evaluasi masing-masing siswa mengenai progress 
pekerjaannya.  

12. Menutup pelajaran  Sebelum pertemuan diakhiri, guru memberikan resume 
mengenai manfaat dan ilmu yang dipelajari pada pertemuan 
tersebut. Setelah itu guru juga mengingatkan bagi siswa yang 
belum selesai mengerjakan tugas, diwajibkan meneruskan pada 
pertemuan berikutnya.  
Guru mengakhiri pelajaran dengan mengucap selamat siang dan 
masih melayani siswa yang akan menilaikan tugasnya.  

C  Perilaku Siswa   

1. Perilaku siswa di dalam 
kelas  

- Sejak awal, kondisi kelas dan ketertiban siswa kurang 
terkondisikan.  

- Ketika di tengah KBM ada ’permohonan bantuan’ dari 
siswa kelas lain (bukti solidaritas) pun tidak meminta izin 
pada guru terlebih dahulu.  

- Siswa mulai semakin ricuh ketika jam pelajaran hampir 
habis dan tugas belum terselesaikan.  

- Selama pelajaran berlangsung, terlihat solidaritas antar 
kawan.  

- Guru tidak berusaha mengkondisikan, sehingga siswa 
berkreatifitas tanpa batas (siswa saling mengajari tetapi 
ada kecenderungan untuk ramai). 

- Banyak siswa yang membolos pelajaran ditunjukkan dari 
tidak adanya keterangan siswa yang absen.  

- Suasana kelas kurang aktif dan hasil belajar rendah.  
 

2. Perilaku siswa di luar 
kelas  

Perilaku siswa di luar kelas cukup baik dan berusaha 
menerapkan 4S (senyum sapa salam sopan), namun belum 
mencakup keseluruhan siswa.  

 
 
        Yogyakarta, 16 Februari 2012 

Menyetujui, 

Guru TIK,  

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa Penelitian, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
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Lampiran 2. Silabus  



       

SILABUS  TINGKAT  SATUAN  PENDIDIKAN 

TEKNOLOGI INFORMASI DAN KOMUNIKASI 

KELAS X 

 

Nama Sekolah  : SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi  Informasi dan Komunikasi 

Kelas / Semester  : X / 2 

Standar Kompetensi  : 1. Menggunakan Perangkat Lunak Pembuat Presentasi  

 

Kompetensi 

Dasar  

Materi 

Pembelajaran 

Kegiatan Pembelajaran Indikator Pencapaian Penilaian Alokasi 

Waktu 

(menit)  

Sumber / 

Bahan / Alat 

1.1. 

Menggunakan 

menu, ikon 

yang terdapat 

pada 

perangkat 

lunak pembuat 

presentasi  

 

 

 Kelebihan 

dan 

kekurangan 

berbagai 

paket 

aplikasi 

pembuat 

presentasi  

 Dasar-dasar 

pembuatan 

dokumen 

presentasi  

yang baik 

 Menu, ikon 

dan perintah 

dalam Office 

Power Point  

Tatap Muka :  

 Mendemonstrasikan 

cara membuka 

program pembuat 

presentasi  

 Mendemonstrasikan 

cara menampilkan 

menu dan ikon  

 Mendemonstrasikan 

cara menyembunyikan 

menu dan ikon 

Mandiri Terstruktur :  

 Menggali informasi 

manfaat program 

presentasi  

 Menggali informasi 

berbagai jenis program 

presentasi  

 Mencari visualisasi 

fungsi menu, tools, 

ikon 

 Menunjukkan beberapa 

menu, tools dan ikon 

sesuai dengan 

fungsinya  

 

 

 Membuka program 

pembuat presentasi  

 

 Mengidentifikasi 

fungsi menu, tools 

dan ikon dalam 

program presentasi  

 

 Tertulis  

 

 

 Hasil kerja 

praktek  

 

2 x 50   Fasilitas Help 

Program 

 Joe H, Office 

VP 8 in 1, Que 

Techmedia, 

2001  

 Internet  

 Labsheet  



       

Kompetensi 

Dasar  

Materi 

Pembelajaran 

Kegiatan Pembelajaran Indikator Pencapaian Penilaian Alokasi 

Waktu 

(menit)  

Sumber / 

Bahan / Alat 

1.2  Membuat 

presentasi 

teks dengan 

variasi tabel, 

grafik, 

gambar, 

diagram dan 

hyperlink  

 

 Fungsi menu 

dan ikon 

serta 

perintah 

dalam 

aplikasi 

office 

powerpoint  

 Membuat 

media 

presentasi 

dengan 

variasi tabel, 

grafik, 

gambar dan 

diagram  

Tatap Muka :  

 Menyiapkan halaman 

baru untuk membuat 

presentasi  

 Menyimpan data file 

dengan nama baru 

 Mencermati visualisasi 

format teks, jenis font, 

ukuran, warna, letak, 

dll 

 Memanfaatkan word 

art sebagai bagian dari 

tampilan presentasi 

 Mengatur tampilan 

background pada tiap 

halaman menggunakan 

slide yang tersedia 

 Menampilkan 

background dengan 

foto / gambar ciri 

kedaerahan.  

 Menyisipkan gambar 

dalam slide 

 Menempatkan objek 

dari berbagai sumber 

dan media di lembar 

presentasi 

 Mengatur tampilan 

slide dengan animasi 

yang ada dalam tools 

 Mengatur waktu 

tampilan slide sesuai 

kebutuhan  

 Menghubungkan 

dokumen antar slide 

 

 Membuat presentasi 

menggunakan 

template  

 Membuat halaman 

presentasi dengan 

menggunakan text 

box dan word art 

 Memodifikasi 

tampilan halaman 

dengan 

memanfaatkan 

background  

 Membuat presentasi 

dengan variasi 

gambar, tabel, 

diagram dan grafik 

 Memodifikasi 

tampilan presentasi 

dengan 

memanfaatkan 

custom animation  

 Memodifikasi 

tampilan presentasi 

dengan 

memanfaatkan 

fasilitas efek transisi 

 Menentukan durasi 

presentasi dan 

Membuat slide 

presentasi yang 

berjalan otomatis 

 Menggabungkan 

dokumen presentasi 

dengan hyperlink 

 Tertulis  

 

 Penugasan 

praktek 

individu  

 

 Hasil kerja 

berupa file 

presentasi  

2 x 50 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fasilitas Help 

 Animation 

Factory 

template and 

graphic  

 Gambar dari 

internet  

 Labsheet  

 

 

 

 Seperangkat 

Komputer 

dengan 

software 

Power Point 



       

Kompetensi 

Dasar  

Materi 

Pembelajaran 

Kegiatan Pembelajaran Indikator Pencapaian Penilaian Alokasi 

Waktu 

(menit)  

Sumber / 

Bahan / Alat 

Mandiri Terstruktur  

 Membuat slide dengan 

grafik yang divariasi 

dan tabel yang 

diformat  

 Membuat slide dengan 

menampilkan diagram 

struktur organisasi, 

cycle dan grafik 

 Membuat slide dengan 

variasi design template  

 Membuat slide dengan 

animasi 

 Membuat slide dengan 

variasi animasi 

 Membuat slide dengan 

hyperlink  

6 x 50  

Sleman, 13 Juli  2009 

Mengetahui,                  

Kepala SMA N 1 Kalasan,              Guru Mata Pelajaran TIK, 

  

 

 

Drs. H. Tri Sugiharto                                                 Arief Budiman, S.Pd.  

NIP. 19570707 198103 1 024           NIP. 19761123 200501 1 014 
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Lampiran 3. RPP Kelas Eksperimen  



RENCANA PELAKSANAAN PEMBELAJARAN 

 

Sekolah  :  SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Kelas / Semester  : X / 2  

Pertemuan ke -  : 1 (satu)    

Materi Pokok  : Ms. Office Power Point   

Alokasi Waktu  : 2 x 50 menit  

Nomor Lab Sheet  : 1   

 

I. Standar Kompetensi  

Menggunakan perangkat lunak pembuat presentasi  

II. Kompetensi Dasar  

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram   

III. Indikator  

1. Siswa dapat membuat dokumen presentasi dengan variasi gambar   

IV. Tujuan Pembelajaran  

Setelah pembelajaran siswa dapat :  

1. Siswa dapat membuat dokumen presentasi dengan variasi gambar   

V. Materi Pembelajaran  

1. Membuat presentasi menggunakan Ms. Office Power Point  

VI. Metode Pembelajaran  

1. Demonstrasi  

2. Diskusi  

3. E-Learning 

VII. Kegiatan Pembelajaran  

No

.  

Kegiatan  Guru  Siswa  Media  Alokasi 

waktu 

(menit)  

1. Kegiatan awal  

1. Membuka 

pelajaran  

2. Apersepsi  

3. Topik materi  

1. Mengucap salam 

dan 

mempersilakan 

salah satu siswa 

untuk memimpin 

berdoa  

 

2. Memberikan 

motivasi 

 

3. Menyampaikan 

standar 

kompetensi dan 

kompetensi 

dasar  

1. Menjawab 

salam dan 

berdoa 

bersama  

 

 

 

2. Siswa 

memperhatika

n guru  

3. Siswa siap 

menerima 

pelajaran  

Slide 

presentasi  

15’ 

2. Kegiatan inti  1. Mendemonstrasi

kan sekaligus 

mempraktekkan 

tentang 

penyisipan dan 

editing gambar 

pada aplikasi 

Power Point   

2. Memberi tugas 

(labsheet)  

1. Siswa 

memperhatika

n guru 

kemudian 

mengikuti 

praktek  

 

 

2. Mengerjakan 

tugas    

Komputer, 

viewer,file 

presentasi, 

labsheet, 

jaringan 

internet, E-

Learning  

70’ 



3. Penutup  

1. Evaluasi  

2. Rangkuman  

3. Tugas  

4. Pesan  

1. Merangkum 

materi dan 

memberikan 

kesimpulan 

materi yang 

sudah 

disampaikan  

2. Menginformasi

kan kegiatan 

pertemuan 

selanjutnya 

3. Menutup 

pelajaran 

dengan doa dan 

salam. 

1. Siswa 

memperhatika

n guru 

2. Siswa 

memperhatika

n guru 

3. Siswa berdoa 

dan menjawab 

salam 

- 15’ 

 

VIII. Alat dan Sumber Belajar 

Labsheet, Bahan dari internet 

IX. Penilaian  

1. Keaktifan dalam diskusi (poin plus)  

2. Tugas individu  

Soal :  

a. Membuat animasi transisi sederhana seperti yang telah tercantum pada labsheet 1.  

 

Yogyakarta, 13 Maret 2012  

Menyetujui, 

Guru Pembimbing 

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa PPL, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
 

 

 

 

 

 

 

 

 

 

 

 



RENCANA PELAKSANAAN PEMBELAJARAN 

 

Sekolah  :  SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Kelas / Semester  : X / 2  

Pertemuan ke -  : 2 (dua)    

Materi Pokok  : Ms. Office Power Point   

Alokasi Waktu  : 2 x 50 menit  

Nomor Lab Sheet  : 2   

 

I. Standar Kompetensi  

Menggunakan perangkat lunak pembuat presentasi  

II. Kompetensi Dasar  

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram   

III. Indikator  

1. Siswa dapat membuat dokumen presentasi dengan design template dan hyperlink    

IV. Tujuan Pembelajaran  

Setelah pembelajaran siswa dapat :  

1. Siswa dapat membuat dokumen presentasi dengan design template dan hyperlink  

V. Materi Pembelajaran  

1. Membuat presentasi menggunakan Ms. Office Power Point  

VI. Metode Pembelajaran  

1. Presentasi  

2. Diskusi  

3. E-Learning 

VII. Kegiatan Pembelajaran  

No

.  

Kegiatan  Guru  Siswa  Media  Alokasi 

waktu 

(menit)  

1. Kegiatan awal  

1. Membuka 

pelajaran  

2. Apersepsi  

3. Topik materi  

1. Mengucap salam 

dan 

mempersilakan 

salah satu siswa 

untuk memimpin 

berdoa  

 

2. Memberikan 

motivasi 

 

3. Menyampaikan 

standar 

kompetensi dan 

kompetensi 

dasar  

1. Menjawab 

salam dan 

berdoa 

bersama  

 

 

 

2. Siswa 

memperhatika

n guru  

3. Siswa siap 

menerima 

pelajaran  

Slide 

presentasi  

15’ 

2. Kegiatan inti  1. Mendemonstrasi

kan sekaligus 

mempraktekkan 

tentang 

hyperlink pada 

aplikasi Power 

Point   

2. Memberi tugas 

(labsheet)  

 

1. Siswa 

memperhatika

n guru 

kemudian 

mengikuti 

praktek  

 

2. Mengerjakan 

tugas    

Komputer, 

viewer,file 

presentasi, 

labsheet, 

jaringan 

internet, E-

learning  

70’ 



3. Penutup  

1. Evaluasi  

2. Rangkuman  

3. Tugas  

4. Pesan  

1. Merangkum 

materi dan 

memberikan 

kesimpulan 

materi yang 

sudah 

disampaikan  

2. Menginformasi

kan kegiatan 

pertemuan 

selanjutnya 

3. Menutup 

pelajaran 

dengan doa dan 

salam. 

1. Siswa 

memperhatika

n guru 

2. Siswa 

memperhatika

n guru 

3. Siswa berdoa 

dan menjawab 

salam 

 15’ 

 

VIII. Alat dan Sumber Belajar 

Labsheet, Bahan dari internet 

IX. Penilaian  

1. Keaktifan dalam diskusi (poin plus)  

2. Tugas individu  

Soal :  

a. Membuat animasi sederhana menggunakan hyperlink seperti yang telah tercantum pada 

labsheet 2.  

 

Yogyakarta, 13 Maret 2012  

Menyetujui, 

Guru Pembimbing 

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa PPL, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
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Lampiran 4. RPP Kelas Kontrol  



RENCANA PELAKSANAAN PEMBELAJARAN 

 

Sekolah  :  SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Kelas / Semester  : X / 2  

Pertemuan ke -  : 1 (satu)    

Materi Pokok  : Ms. Office Power Point   

Alokasi Waktu  : 2 x 50 menit  

Nomor Lab Sheet  : 1   

 

I. Standar Kompetensi  

Menggunakan perangkat lunak pembuat presentasi  

II. Kompetensi Dasar  

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram   

III. Indikator  

1. Siswa dapat membuat dokumen presentasi dengan variasi gambar   

IV. Tujuan Pembelajaran  

Setelah pembelajaran siswa dapat :  

1. Siswa dapat membuat dokumen presentasi dengan variasi gambar   

V. Materi Pembelajaran  

1. Membuat presentasi menggunakan Ms. Office Power Point  

VI. Metode Pembelajaran  

1. Demonstrasi  

2. Diskusi  

3. E-Learning 

VII. Kegiatan Pembelajaran  

No

.  

Kegiatan  Guru  Siswa  Media  Alokasi 

waktu 

(menit)  

1. Kegiatan awal  

1. Membuka 

pelajaran  

2. Topik materi  

1. Mengucap salam 

dan 

mempersilakan 

salah satu siswa 

untuk memimpin 

berdoa  

 

2. Menyampaikan 

standar 

kompetensi dan 

kompetensi 

dasar  

1. Menjawab 

salam dan 

berdoa 

bersama  

 

 

 

2. Siswa siap 

menerima 

pelajaran  

Ceramah  15’ 

2. Kegiatan inti  1. Mendemonstrasi

kan sekaligus 

mempraktekkan 

tentang 

penyisipan dan 

editing gambar 

pada aplikasi 

Power Point   

 

1. Siswa 

memperhatika

n guru 

kemudian 

mengikuti 

praktek 

sekaligus 

mengerjakan 

tugas   

Komputer, 

viewer,file 

presentasi 

70’ 

3. Penutup  

1. Evaluasi  

2. Rangkuman  

3. Pesan untuk 

1. Merangkum 

materi dan 

memberikan 

kesimpulan 

1. Siswa 

memperhatika

n guru 

2. Siswa 

Ceramah  15’ 



menilaikan 

tugas bagi 

siswa yang 

belum selesai  

materi yang 

sudah 

disampaikan  

2. Menginformasi

kan kegiatan 

pertemuan 

selanjutnya 

3. Menutup 

pelajaran 

dengan doa dan 

salam. 

memperhatika

n guru 

3. Siswa berdoa 

dan menjawab 

salam 

 

VIII. Alat dan Sumber Belajar 

Presentasi Powerpoint guru 

IX. Penilaian  

1. Keaktifan dalam diskusi (poin plus)  

2. Tugas individu  

Soal :  

a. Membuat animasi transisi sederhana seperti yang telah dicontohkan guru.  

 

Yogyakarta, 13 Maret 2012  

Menyetujui, 

Guru Pembimbing 

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



RENCANA PELAKSANAAN PEMBELAJARAN 

 

Sekolah  :  SMA Negeri 1 Kalasan  

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Kelas / Semester  : X / 2  

Pertemuan ke -  : 2 (dua)    

Materi Pokok  : Ms. Office Power Point   

Alokasi Waktu  : 2 x 50 menit  

Nomor Lab Sheet  : 2   

 

I. Standar Kompetensi  

Menggunakan perangkat lunak pembuat presentasi  

II. Kompetensi Dasar  

Membuat presentasi teks dengan variasi tabel, grafik, gambar dan diagram   

III. Indikator  

1. Siswa dapat membuat dokumen presentasi dengan design template dan hyperlink    

IV. Tujuan Pembelajaran  

Setelah pembelajaran siswa dapat :  

1. Siswa dapat membuat dokumen presentasi dengan design template dan hyperlink  

V. Materi Pembelajaran  

1. Membuat presentasi menggunakan Ms. Office Power Point  

VI. Metode Pembelajaran  

1. Presentasi  

2. Diskusi  

3. E-Learning 

VII. Kegiatan Pembelajaran  

No

.  

Kegiatan  Guru  Siswa  Media  Alokasi 

waktu 

(menit)  

1. Kegiatan awal  

1. Membuka 

pelajaran  

2. Topik materi  

1. Mengucap salam 

dan 

mempersilakan 

salah satu siswa 

untuk memimpin 

berdoa  

 

2. Menyampaikan 

standar 

kompetensi dan 

kompetensi 

dasar  

1. Menjawab 

salam dan 

berdoa 

bersama  

 

 

 

2. Siswa siap 

menerima 

pelajaran  

Ceramah  15’ 

2. Kegiatan inti  1. Mendemonstrasi

kan sekaligus 

mempraktekkan 

tentang 

hyperlink pada 

aplikasi Power 

Point   

2. Memberi tugas 

(labsheet)  

 

1. Siswa 

memperhatika

n guru 

kemudian 

mengikuti 

praktek 

sekaligus 

mengerjakan 

tugas   

Komputer, 

viewer,file 

presentasi 

70’ 

3. Penutup  

1. Evaluasi  

2. Rangkuman  

1. Merangkum 

materi dan 

memberikan 

1. Siswa 

memperhatika

n guru 

Ceramah  15’ 



3. Pesan untuk 

menilaikan 

tugas bagi 

siswa yang 

belum selesai  

kesimpulan 

materi yang 

sudah 

disampaikan  

2. Menginformasi

kan kegiatan 

pertemuan 

selanjutnya 

3. Menutup 

pelajaran 

dengan doa dan 

salam. 

2. Siswa 

memperhatika

n guru 

3. Siswa berdoa 

dan menjawab 

salam 

 

VIII. Alat dan Sumber Belajar 

Presentasi Powerpoint guru 

IX. Penilaian  

1. Keaktifan dalam diskusi (poin plus)  

2. Tugas individu  

Soal :  

a. Membuat animasi sederhana menggunakan hyperlink seperti yang telah dicontohkan guru.  

 

 

Yogyakarta, 13 Maret 2012  

Menyetujui, 

Guru Pembimbing 

 

 

 

Arief Budiman, S.Pd.  

NIP. 19761123 200501 1 014 

 

Mahasiswa, 

 

 

 

Mawar Ramadhani 

NIM. 08520241028 
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Lampiran 5. Lembar Validasi Ahli  



 

 

LEMBAR VALIDASI INSTRUMEN TES HASIL BELAJAR 

 

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Materi Pokok   : Perangkat Lunak Pembuat Presentasi (Ms. Office Power Point) 

Sasaran Program  : Siswa Kelas X SMA Negeri 1 Kalasan 

Validator   : Umi Rochayati, M.T.  

Peneliti  : Mawar Ramadhani 

 

A. Petunjuk 1 

1. Lembar Validasi ini diisi oleh ahli (judgment expert)  

2. Validasi ini dimaksudkan untuk mengungkap tanggapan bapak / ibu sebagai ahli 

(judgment expert) terhadap instrumen tes hasil belajar Teknologi Informasi dan 

Komunikasi ditinjau dari aspek pembelajaran, aspek kebenaran isi, komentar 

umum dan kesimpulan.  

3. Penilaian dimulai dengan rentangan sangat kurang baik (SK) sampai sangat baik 

(SB). Silakan memberikan tanda cek (√) pada kolom yang sesuai menurut 

pendapat bapak / ibu selaku ahli (judgment expert).  

4. Keterangan skala :  

SB  : Sangat Baik (dengan skor 5) 

B : Baik (dengan skor 4) 

C : Cukup baik (dengan skor 3) 

K : Kurang baik (dengan skor 2) 

SK : Sangat kurang baik (dengan skor 1)  

5. Komentar san saran bapak / ibu mohon dituliskan pada lembar yang telah 

disediakan. Apabila tempat tidak mencukupi, mohon ditulis pada lembar 

tambahan yang telah disediakan.  

6. Atas kesediaan bapak / ibu dalam mengisi lembar validasi, saya sampaikan 

terimakasih.  

 

 

 

 

 



 

 

No. Indikator Skala 

1 2 3 4 5 

1  Kejelasan rumusan standar kompetensi     √  

2 Kesesuaian kompetensi dasar dengan standar 

kompetensi  

   √  

3 Kejelasan indikator keberhasilan     √  

4  Kejelasan sasaran program     √  

5 Ketepatan materi dikaitkan dengan kompetensi 

dasar  

   √  

6 Kejelasan petunjuk mengerjakan tes     √  

7 Kesesuaian soal tes dengan materi    √  

8 Kecukupan soal tes     √  

9 Variasi bentuk soal     √  

10 Kebenaran penggunaan bahasa sesuai EYD 

dalam soal tes  

  √   

11 Kesesuaian soal tes dengan standar kompetensi     √  

12 Kesesuaian soal tes dengan kompetensi dasar     √  

13 Kesesuaian soal tes dengan indikator 

keberhasilan  

   √  

Jumlah      

Penilaian secara umum Kesimpulan Penilaian 

LD LDR TLD 

Penilaian secara umum terhadap instrumen tes  √  

 

Keterangan :  

LD  : Layak Digunakan 

LDR  : Layak Digunakan dengan Revisi 

TLD : Tidak Layak Digunakan  

 

B. Petunjuk 2  

1. Apabila terdapat komentar, mohon dituliskan pada kolom 2 

2. Pada kolom silakan diisi saran untuk perbaikan  

No. Bagian yang perlu diperbaiki Saran perbaikan 

1  Penulisan efek keluar  Diperjelas maksudnya  

2   

3   

 



 

 

Komentar / saran umum :  

 

Layak digunakan.  

 

Kesimpulan :  

Instrumen ini dinyatakan :  

1. Layak untuk uji coba lapangan tanpa revisi  

2. Layak uji coba lapangan dengan revisi sesuai saran  

3. Tidak layak uji coba  

 

 

Yogyakarta, 26 Maret 2012 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Validator, 

 

 

 

Umi Rochayati, M.T.  

NIP. 19630528 198710 2 001 



 

 

LEMBAR VALIDASI INSTRUMEN TES HASIL BELAJAR 

 

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Materi Pokok   : Perangkat Lunak Pembuat Presentasi (Ms. Office Power Point) 

Sasaran Program  : Siswa Kelas X SMA Negeri 1 Kalasan 

Validator   : Masduki Zakaria, M.T.  

Peneliti  : Mawar Ramadhani 

 

A. Petunjuk 1 

1. Lembar Validasi ini diisi oleh ahli (judgment expert)  

2. Validasi ini dimaksudkan untuk mengungkap tanggapan bapak / ibu sebagai ahli 

(judgment expert) terhadap instrumen tes hasil belajar Teknologi Informasi dan 

Komunikasi ditinjau dari aspek pembelajaran, aspek kebenaran isi, komentar 

umum dan kesimpulan.  

3. Penilaian dimulai dengan rentangan sangat kurang baik (SK) sampai sangat baik 

(SB). Silakan memberikan tanda cek (√) pada kolom yang sesuai menurut 

pendapat bapak / ibu selaku ahli (judgment expert).  

4. Keterangan skala :  

SB  : Sangat Baik (dengan skor 5) 

B : Baik (dengan skor 4) 

C : Cukup baik (dengan skor 3) 

K : Kurang baik (dengan skor 2) 

SK : Sangat kurang baik (dengan skor 1)  

5. Komentar san saran bapak / ibu mohon dituliskan pada lembar yang telah 

disediakan. Apabila tempat tidak mencukupi, mohon ditulis pada lembar 

tambahan yang telah disediakan.  

6. Atas kesediaan bapak / ibu dalam mengisi lembar validasi, saya sampaikan 

terimakasih.  

 

 

 

 

 



 

 

No. Indikator Skala 

1 2 3 4 5 

1  Kejelasan rumusan standar kompetensi     √  

2 Kesesuaian kompetensi dasar dengan standar 

kompetensi  

   √  

3 Kejelasan indikator keberhasilan     √  

4  Kejelasan sasaran program     √  

5 Ketepatan materi dikaitkan dengan kompetensi 

dasar  

  √   

6 Kejelasan petunjuk mengerjakan tes     √  

7 Kesesuaian soal tes dengan materi    √  

8 Kecukupan soal tes     √  

9 Variasi bentuk soal    √   

10 Kebenaran penggunaan bahasa sesuai EYD 

dalam soal tes  

  √   

11 Kesesuaian soal tes dengan standar kompetensi     √  

12 Kesesuaian soal tes dengan kompetensi dasar     √  

13 Kesesuaian soal tes dengan indikator 

keberhasilan  

   √  

Jumlah      

Penilaian secara umum Kesimpulan Penilaian 

LD LDR TLD 

Penilaian secara umum terhadap instrumen tes  √  

 

Keterangan :  

LD  : Layak Digunakan 

LDR  : Layak Digunakan dengan Revisi 

TLD : Tidak Layak Digunakan  

 

B. Petunjuk 2  

1. Apabila terdapat komentar, mohon dituliskan pada kolom 2 

2. Pada kolom silakan diisi saran untuk perbaikan  

No. Bagian yang perlu diperbaiki Saran perbaikan 

1    

2   

3   

 



 

 

Komentar / saran umum :  

 

1. Landasan teoritik dari soal yang mudah ke sulit atau sulit ke yang mudah, 

atau acak. 

2. Validitas isi gunakan item analisis atau analisis butir.  

 

Kesimpulan :  

Instrumen ini dinyatakan :  

1. Layak untuk uji coba lapangan tanpa revisi  

2. Layak uji coba lapangan dengan revisi sesuai saran  

3. Tidak layak uji coba  

 

Yogyakarta, 29 Maret 2012 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Validator, 

 

 

 

Masduki Zakaria, M.T.   

NIP. 19640917 198901 1 001 



 

 

LEMBAR VALIDASI INSTRUMEN TES HASIL BELAJAR 

 

Mata Pelajaran  : Teknologi Informasi dan Komunikasi  

Materi Pokok   : Perangkat Lunak Pembuat Presentasi (Ms. Office Power Point) 

Sasaran Program  : Siswa Kelas X SMA Negeri 1 Kalasan 

Validator   : Arief Budiman, S.Pd.   

Peneliti  : Mawar Ramadhani 

 

A. Petunjuk 1 

1. Lembar Validasi ini diisi oleh ahli (judgment expert)  

2. Validasi ini dimaksudkan untuk mengungkap tanggapan bapak / ibu sebagai ahli 

(judgment expert) terhadap instrumen tes hasil belajar Teknologi Informasi dan 

Komunikasi ditinjau dari aspek pembelajaran, aspek kebenaran isi, komentar 

umum dan kesimpulan.  

3. Penilaian dimulai dengan rentangan sangat kurang baik (SK) sampai sangat baik 

(SB). Silakan memberikan tanda cek (√) pada kolom yang sesuai menurut 

pendapat bapak / ibu selaku ahli (judgment expert).  

4. Keterangan skala :  

SB  : Sangat Baik (dengan skor 5) 

B : Baik (dengan skor 4) 

C : Cukup baik (dengan skor 3) 

K : Kurang baik (dengan skor 2) 

SK : Sangat kurang baik (dengan skor 1)  

5. Komentar san saran bapak / ibu mohon dituliskan pada lembar yang telah 

disediakan. Apabila tempat tidak mencukupi, mohon ditulis pada lembar 

tambahan yang telah disediakan.  

6. Atas kesediaan bapak / ibu dalam mengisi lembar validasi, saya sampaikan 

terimakasih.  

 

 

 

 

 



 

 

No. Indikator Skala 

1 2 3 4 5 

1  Kejelasan rumusan standar kompetensi  √     

2 Kesesuaian kompetensi dasar dengan standar 

kompetensi  

√     

3 Kejelasan indikator keberhasilan   √    

4  Kejelasan sasaran program   √    

5 Ketepatan materi dikaitkan dengan kompetensi 

dasar  

 √    

6 Kejelasan petunjuk mengerjakan tes   √    

7 Kesesuaian soal tes dengan materi  √    

8 Kecukupan soal tes   √    

9 Variasi bentuk soal    √   

10 Kebenaran penggunaan bahasa sesuai EYD 

dalam soal tes  

 √    

11 Kesesuaian soal tes dengan standar kompetensi   √    

12 Kesesuaian soal tes dengan kompetensi dasar   √    

13 Kesesuaian soal tes dengan indikator 

keberhasilan  

 √    

Jumlah      

Penilaian secara umum Kesimpulan Penilaian 

LD LDR TLD 

Penilaian secara umum terhadap instrumen tes  √  

 

Keterangan :  

LD  : Layak Digunakan 

LDR  : Layak Digunakan dengan Revisi 

TLD : Tidak Layak Digunakan  

 

B. Petunjuk 2  

1. Apabila terdapat komentar, mohon dituliskan pada kolom 2 

2. Pada kolom silakan diisi saran untuk perbaikan  

No. Bagian yang perlu diperbaiki Saran perbaikan 

1  Terdapat kata “bukan” Diganti kata “kecuali” 

2 Istilah yang asing pada Power Point  Diganti dengan yang dikenal  

3   

 



 

 

Komentar / saran umum :  

 

Sudah layak digunakan dengan beberapa perbaikan yang telah disarankan.  

 

Kesimpulan :  

Instrumen ini dinyatakan :  

1. Layak untuk uji coba lapangan tanpa revisi  

2. Layak uji coba lapangan dengan revisi sesuai saran  

3. Tidak layak uji coba  

 

 

Yogyakarta, 29 Maret 2012 

 

 

 

 

 

 

 

Validator, 

 

 

 

Arief Budiman, S.Pd. 

NIP. 19761123 200501 1 014 
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Lampiran 6. Surat Keterangan Validator  



SURAT KETERANGAN VALIDASI INSTRUMEN

Yang bertandatangandi bawah ini :

Nama . UUI RoCHA\ATi, MT.
NIP : l967cst8 l9g+1o z ool

Setelah membaca dan memeriksa instrument penelitian skripsi yang be{udul 66Efektivitas

Penggunaan Media Pembelajaran E-Learning Berbasis lYeb Based Training Terhadap

Hasil Belajar Siswa Mata Pelajaran Teknologi Informasi dan Komunikasi Kelas X SMA

Negeri 1 Kalasan", oleh peneliti :

Nama : Mawar Ramadhani

NIM :08520241028

Prodi : Pendidikan Teknik Informatika

Maka dengan ini menyatakan bahwa butir - butir soal pilihan ganda yang ada pada instrument

ini *) :

a. Layak digunakan untuk penelitian dengan revisi sesuai saran sebagai berikut :

QenutrTan 6oal eeuai L\D

Layak digunakan untuk penelitian tanpa revisi.

b. Tidak layak digunakan untuk penelitian.

Demikian surat keterangan ini dibuat dan untuk digunakan sebagaimana mestinya.

Yogyakart", zg Mxte[ ?ott

NIP. t6rlosX8 \Oeao tool

*) Lingkari pada huruf yang sesuai dengan pendapat Bapak Ibu



SURAT KETERANGAN VALIDASI INSTRUMEN

:

Yang bertanda tangan di bawah ini :

Nama : MfsUlFt arF.ARlA, M.t.
NIp : 0G1o5lT l981ot r oot

Setelah membaca dan memeriksa instrument penelitian skripsi yang be{udul "Efektivitas
Penggunaan Media Pembelajaran E-Learning Berba sis lYeb Based Training Terhadap

Hasil Belajar Siswa Mata Pelajaran Teknologi Informasi dan Komunikasi Kelas X SMA

Negeri L Kalasan", oleh peneliti :

Nama : Mawar Ramadhani

NIM z 0852024fi28

Prodi : Pendidikan Teknik Informatika

Maka dengan ini menyatakan bahwa butir - butir soal pilihan ganda yang ada pada instrument

ini *) :

a. Layakdigunakanuntuk tian dengan revisi sesuai saran sebaga!

Layak digunakan untuk penelitian tanpa revisi.

b. Tidak layak digunakan untuk penelitian.

Demikian surat keterangan ini dibuat dan untuk digunakan sebagaimana mestinya.

t2 L"w-

(

Yogyakarta,

Validator,

NIP. le6qo1Y+ \,egol :c,ol

*) Lingkari pada huruf yang sesuai dengan pendapat Bapak Ibu



SURAT KETERANGAII VALIDASI INSTRUMEN

Yang bertandatangan di bawah ini :

Nama : AS\EF TS\-rD I I4AAJ
NIP

Setelah membaca dan memeriksa instrument penelitian skripsi yang be{udul ooEfektivitas

Penggunaan Media Pembelajaran E-Learning Berbasis Web Based Training Terhadap

Hasil Belajar Siswa Mata Pelajaran Teknologi Informasi dan Komunikasi Kelas X SMA
Negeri 1 Kalasano', oleh peneliti :

Nama : Mawar Ramadhani

NIM :08520241028

Prodi : Pendidikan Teknik Informatika

Maka dengan ini menyatakan bahwa butir - butir soal pilihan ganda yang ada pada instrument

ini *) :

I il I-avak disunakan untuk penelitian dengan revisi sesuai saran sebagai berikut :V

Layak digunakan untuk penelitian tanpa revisi.

b. Tidak layak digunakan untuk penelitian.

Demikian surat keterangan ini dibuat dan untuk digunakan sebagaimana mestinya.

Yogyakart^, t9 Mofu( uru

Validator,

(

NIP.

*) Lingkari pada hurufyang sesuai dengan pendapat Bapak Ibu
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Lampiran 7. Kisi-Kisi Soal  



 

 

Kisi–Kisi Instrumen Soal Tes 

“Efektivitas Penggunaan Media Pembelajaran E-Learning Berbasis Web  

Pada Pelajaran Teknologi Informasi dan Komunikasi Terhadap Hasil Belajar  

Siswa Kelas X SMA Negeri 1 Kalasan” 

No. Standar 

Kompetensi  

Kompetensi 

Dasar 

Materi Pokok Indikator Tipe tes  No. Soal 

(Pretest)  

No. Soal 

(Postest)  

Jumlah 

Butir  

1.  Menggunakan 

perangkat 

lunak 

pembuat 

presentasi  

Membuat 

presentasi 

teks dengan 

variasi 

gambar, 

animasi dan 

hyperlink  

 Fungsi menu 

dan ikon serta 

perintah 

dalam 

aplikasi Ms. 

Office Power 

Point  

 

 

 

 

 

 

 

 

1. Membuka program pembuat 

presentasi  

2. Mengidentifikasi menu, tools, 

icon, shortcut key dan elemen 

dalam program pembuat 

presentasi  

3. Mengetahui istilah dalam 

program pembuat presentasi  

4. Membuat presentasi 

menggunakan layout, text box 

atau WordArt  

5. Memodifikasi tampilan slide 

dengan memanfaatkan 

background  

6. Membuat presentasi dengan 

Penerapan  

 

Pemahaman  

 

 

 

Hafalan  

 

Penerapan  

 

 

Pemahaman 

 

 

Penerapan  

5,10,25 

 

2,3, 22 

 

 

 

1, 7 

 

15, 21 

 

 

6, 18 

 

 

4, 13, 20 

1, 2, 7 

 

8, 10, 23 

 

 

 

5, 19 

 

15, 22 

 

 

9, 20 

 

 

6, 13, 21 

3 

 

3 

 

 

 

2 

 

2 

 

 

2 

 

 

3 



 

 

 Membuat 

media 

presentasi 

dengan 

variasi teks, 

gambar, 

animasi dan 

hyperlink  

variasi teks dan gambar 

7. Memodifikasi tampilan 

presentasi dengan 

memanfaatkan custom 

animation  

8. Memodifikasi tampilan 

presentasi dengan 

memanfaatkan fasilitas slide 

transisi  

9. Membuat slide presentasi 

yang berjalan otomatis dan 

melakukan penyisipan objek 

pada materi presentasi 

10. Menggabungkan dokumen 

presentasi dengan 

menggunakan hyperlink  

 

Pemahaman  

 

 

 

Pemahaman  

 

 

 

Penerapan  

 

 

 

Penerapan  

 

 

11, 14, 23 

 

 

 

16, 17 

 

 

 

8, 9, 12 

 

 

 

19, 24  

 

11, 14, 17 

 

 

 

16, 24 

 

 

 

3, 4, 12 

 

 

 

18, 25 

 

3 

 

 

 

2 

 

 

 

3 

 

 

 

2 

      25 25 25 
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Lampiran 8. Soal Uji Coba  



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

TES UJI COBA  

MEMBUAT PRESENTASI DENGAN VARIASI TEKS, GAMBAR, 

ANIMASI TRANSISI DAN HYPERLINK 

Kriteria mengerjakan postest :  

1. Berdoalah sebelum mengerjakan tes.  

2. Tulis identitas pada lembar ini dengan jelas.   

3. Baca soal dengan baik dan cermati maksudnya.  

4. Pilih satu jawaban yang paling tepat kemudian beri tanda silang pada huruf a, b, c, atau d.  

5. Telitilah kembali setelah selesai mengerjakan soal sebelum diserahkan untuk dinilai.  

 

SELAMAT MENGERJAKAN 
 

Nama Lengkap  : _____________________________________________ 

Kelas / Presensi  : _____________________________________________ 

1. Langkah – langkah membuka (menjalankan) program aplikasi Power Point secara umum adalah.. 

a. Start – Microsoft Power Point 

b. Start – Office – Microsoft Power Point  

c. Start – All Programs – Microsoft Office – Microsoft Power Point  

d. Start – All Programs - Microsoft Power Point 

e. Start – Microsoft – Power Point  

2. Untuk membuka dokumen baru hingga muncul slide presentasi pada Microsoft Power Point 2007 

menggunakan : 

a. File > New 

b. File > Save 

c. File > Open  

d. File > Blank Document  

e. File > New > Blank Presentation  

3. Untuk menambahkan slide baru menggunakan perintah :  

a. Home > New Slide 

b. Home > Picture  

c. File > Save 

d. New > Slide 

e. File > New  

4. Untuk memasukkan gambar di dalam slide menggunakan perintah  

a. Insert > Picture 

b. Insert > New Slide  

c. Insert > Clip Art  

d. Insert > Picture > Clip Art 

e. Insert > Object  

5. Shortcut yang digunakan untuk menyalin slide adalah.. 

a. Ctrl + X 

b. Ctrl + C 

c. Ctrl + E 

d. Ctrl + M 

e. Ctrl + V  

 

6. Perintah yang digunakan untuk merubah bentuk, ukuran dan gaya huruf adalah.. 

a. File – Format – Font 

b. Insert – Format – Font 

c. Format – Font 



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

d. Home – Font  

e. Edit – Format – Font  

7. Perintah yang digunakan untuk merubah layout pada suatu slide adalah.. 

a. Home – Slide 

b. Home – Style Layout  

c. Home – Layout 

d. Home – Design Layout  

e. Home – Slide Layout  

8. Fasilitas layout slide digunakan untuk.. 

a. Animasi layout 

b. Memberi font 

c. Memilih tata letak isi dan content pada slide 

d. Memberi garis bantu  

e. Memberi spasi  

9. Kegunaan dari tombol “Apply” pada kotak dialog format – background adalah.. 

a. Mengaktifkan pilihan pada setiap presentasi  

b. Mengaktifkan pilihan pada presentasi aktif 

c. Mengaktifkan pilihan pada slide sebelumnya 

d. Mengaktifkan pilihan pada slide aktif 

e. Mengaktifkan pilihan pada setiap slide  

10. Menu yang tidak terdapat pada Microsoft Power Point 2007 adalah..  

a. Insert 

b. Review 

c. Add – Ins  

d. Home 

e. Mailings 

11. Berikut ini termasuk Custom Animation, kecuali… 

a. Entrance 

b. Emphasis  

c. Exit  

d. Motion Paths  

e. Animation Scheme  

12. Berikut yang termasuk sub menu dari Slide Show adalah… 

a. New Slide 

b. Slide Number 

c. Chart 

d. Diagram  

e. Rehearse Timings  

13. Yang dimaksud dengan animasi secara umum adalah… 

a. Objek (teks atau gambar) yang bergerak 

b. Objek yang dapat menghilang dan muncul kembali  

c. Gambar kartun  

d. Objek lucu 

e. Gambar diam  

14. Tools animasi yang dapat kita gunakan untuk membuat suatu objek lingkaran dan berputar sesuai garis 

orbit tersebut adalah.. 

a. Hexagon 

b. Spiral 

c. Octagon 

d. Circle  

e. Football  

15. Layout di bawah ini disebut… 

 



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

a. Title slide 

b. Title and Content  

c. Two Content 

d. Content With Caption 

e. Section Header  

16. Yang digunakan untuk mengatur jenis transisi pada presentasi Power Point 2007 adalah … 

 
 

 

a. 1  b. 2  c. 3  d. 4  e. 5  

17. Bagaimana cara membuat teks berganti warna setelah animasi pada teks tersebut selesai?  

a. Pengaturan pada Effect > Direction 

b. Pengaturan pada Effect > After Animation 

c. Pengaturan pada Effect > Animate Text 

d. Pengaturan pada Timing > Repeat 

e. Pengaturan pada Timing > Delay  

18. Menghubungkan beberapa dokumen presentasi dapat dilakukan mengunakan fasilitas...  

a. Cloning  

b. Hyperlink  

c. Grouping  

d. Verifying  

e. Navigasi 

19. Ekstensi file berikut yang merupakan ekstensi dari tipe file powerpoint 2007 adalah...  

a. .ppt   

b. .Gif  

c. .pptx  

d. .Doc  

e. .Xls 

20. Perintah slide layout digunakan untuk …  

a. Menampilkan presentasi satu layar penuh  

b. Menampilkan bentuk-bentuk slide  

c. Menampilkan navigasi  

d. Menampilkan add effect  

e. Menampilkan bentuk-bentuk background 

21. Gambar kotak dialog di bawah digunakan untuk.. 

 
a. Penggabungan Navigasi  

b. Memberikan efek pada huruf  

c. Memberikan efek setelah animasi tertentu selesai   

d. Menggabungkan slide dan navigasi  

e. Menghubungkan slide-slide maupun file dalam extensi yang lain 

2 3 

4 

5 

1 
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22. Untuk membuat nomor halaman pada slide digunakan tools …  

1. Text Box   

2. Word  Art 

3. Clip Art 

4. Emphasis 

5. Font  

Jawaban yang tepat adalah.. 

a. 1,2   

b. 1,5   

c. 5 

d. 3,4   

e. 3,5  

23. Berikut ini yang merupakan sub menu dari menu review adalah.. 

a.  
 

b.  
 

c.  
 

d.  
 

e.  
 

24. Ada beberapa komponen presentasi yang dapat diberi animasi, kecuali.. 

a. Teks    

b. Objek Gambar 

c. Transisi Slide 

d. Peralihan Slide  

e. Layout  

25. Menu berikut yang digunakan untuk membuat hyperlink dengan hanya mengarahkan kursor pada media 

hyperlink terletak pada bagian nomor.. 

  
a. 1 

b. 2   

c. 3 

d. 4   

e. 5  

 

1 

2 

3 

5 4 
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Lampiran 9. Data Kelas dan Hasil Uji Coba  



ATTENDENCE LIST 
CLASS XC 

SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

MEETING DATE  

30/3     INFO  

1 8796 ANAS BANU AJI M 52      

2 8809 ANNISA MAULUDINA F 28      

3 8811 ANNISA WIDYASTUTI F 36      

4 8852 ERY HIKMANNISA DAMAYANTI F 48      

5 8854 ETMA FATMA MILASARI F 36      

6 8855 FACHRY HAJI MAKKIYAH M 80      

7 8873 FITRI MIANDARI F 28      

8 8883 GITHA NURHADY DZULQINA M 72      

9 8889 HANUNG NAWANG PALUPI F 76      

10 8898 IKA MADYARINA MASTUTI F 88      

11 8903 INDAH KUSUMANINGRUM F -      

12 8906 INTAN MAYASARI F 44      

13 8907 INTAN PUSPITASARI F 24      

14 8918 KHOLIFATUN NASIFAH F 56      

15 8928 MUHAMMAD IRFAN HIDAYAT M -      

16 8930 MUSTOFA NUR KHALISMA M 72      

17 8934 NAJMATUSSALAMAH F -      

18 8935 NANDHIWARDHANA DHARMIKA M 72      

19 8937 NIA PUSPITA DEWI F -      

20 8938 NIKY WULANDARI F 92      

21 8944 NURVITA PUSPITA F 76      

22 8947 PRAMITHA PRIMANGGITA AYU A F -      

23 8951 QHORY KUSUMA SATITI F 32      

24 8953 RAGA GLEGAR WICAKSONO M 92      

25 8955 RAHMAWATI UTAMI F 84      

26 8960 RETNO UTAMI F -      

27 8968 RIZDIANA NUR HANI F 28      

28 8971 RIZQI FAZZAR KURNIA M 64      

29 8976 ROSALIA DYAH NUGRAHANI K D  F 24      

30 8991 TUBAGUS MAHESA ABIRAWA P M 48      

31 9004 YENI NUR PRATIWI F -      

32 9005 YOGA RAKHMANTO 
 

-      

   

L : 10 
P : 22  
 

 
∙ 

     

Menyetujui, 

Guru Pembimbing 
 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 
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Lampiran 10. Instrumen Soal Pretest dan Posttest  
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PRETEST  

MEMBUAT PRESENTASI DENGAN VARIASI TEKS, GAMBAR, 

ANIMASI TRANSISI DAN HYPERLINK 

Kriteria mengerjakan postest :  

1. Berdoalah sebelum mengerjakan tes.  

2. Tulis identitas pada lembar ini dengan jelas.   

3. Baca soal dengan baik dan cermati maksudnya.  

4. Pilih satu jawaban yang paling tepat kemudian beri tanda silang pada huruf a, b, c, atau d.  

5. Telitilah kembali setelah selesai mengerjakan soal sebelum diserahkan untuk dinilai.  

 

SELAMAT MENGERJAKAN 
 

Nama Lengkap  : _____________________________________________ 

Kelas / Presensi  : _____________________________________________ 

1. Dalam Ms. Power Point terdapat istilah slide. Slide merupakan..  

a. Istilah halaman dalam power point 

b. Template bawaan yang sudah disediakan Ms. Office 

c. Gambar yang bisa diberi animasi 

d. Gabungan beberapa animasi  

e. Tools untuk scrolling bar 

2. Shortcut yang digunakan untuk paste slide adalah.. 

a. Ctrl + V 

b. Ctrl + C 

c. Ctrl + E 

d. Ctrl + M 

e. Ctrl + X  

 

3. Selain mempergunakan menu Home – Cut untuk memotong atau menghapus teks, dapat diganti dengan 

menekan.. 

a. Ctrl + X 

b. Ctrl + M 

c. Ctrl + S 

d. Ctrl + A 

e. Ctrl + F  

 

4. Perintah yang digunakan untuk merubah bentuk, ukuran dan gaya huruf adalah pada menu.. 

a. Home  

b. Insert  

c. Design  

d. Animation  

e. Format  

 

5. Perintah yang digunakan untuk membuka atau merubah layout pada suatu slide adalah.. 

a. Home – Slide 

b. Home – Style Layout  

c. Home – Layout 

d. Home – Design Layout  

e. Home – Slide Layout  

 

6. Kegunaan dari tombol “Apply” pada kotak dialog format – background adalah.. 

a. Mengaktifkan pilihan pada setiap presentasi  

b. Mengaktifkan pilihan pada presentasi aktif 

c. Mengaktifkan pilihan pada slide sebelumnya 

d. Mengaktifkan pilihan pada slide aktif 

e. Mengaktifkan pilihan pada setiap slide  

7. Menu yang tidak terdapat pada Microsoft Power Point 2007 adalah..  

a. Insert  

b. Review 

c. Add – Ins  

d. Home 

e. Mailings 
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8. Untuk memasukkan gambar di dalam slide menggunakan perintah  

a. Insert > Picture 

b. Insert > New Slide  

c. Insert > Clip Art  

d. Insert > Word Art 

e. Insert > Object  

9. Berikut ini yang bukan termasuk elemen Custom Animation adalah… 

a. Entrance 

b. Emphasis  

c. Exit  

d. Motion Paths  

e. Animation Scheme  

10. Rehearse Timings merupakan sub menu dari menu… 

a. View  

b. Animation  

c. Home  

d. Insert   

e. Slide Show 

11. Yang dimaksud dengan animasi secara umum adalah… 

a. Objek (teks atau gambar) yang bergerak 

b. Objek yang dapat menghilang dan muncul kembali  

c. Gambar kartun  

d. Objek lucu 

e. Gambar diam  

12. Tools animasi yang dapat kita gunakan untuk membuat suatu objek segi enam dan berputar sesuai garis 

tersebut adalah.. 

a. Hexagon 

b. Spiral 

c. Octagon 

d. Circle  

e. Football  

13. Layout di bawah ini disebut… 

 
a. Title slide 

b. Title and Content  

c. Two Content 

d. Content With Caption 

e. Section Header  

14. Ada beberapa komponen presentasi yang dapat diberi animasi, kecuali.. 

a. Teks 

b. Objek Gambar 

c. Transisi Slide 

d. Peralihan Slide 

e. Layout  

15. Perintah slide layout digunakan untuk  

a. Menampilkan presentasi satu layar penuh  

b. Menampilkan bentuk-bentuk slide  

c. Menampilkan navigasi  

d. Menampilkan add effect  

e. Menampilkan bentuk-bentuk background 

16. Gambar kotak dialog di bawah digunakan untuk.. 
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a. Penggabungan Navigasi  

b. Memberikan efek pada huruf  

c. Memberikan efek setelah animasi tertentu selesai   

d. Menggabungkan slide dan navigasi  

e. Menghubungkan slide-slide maupun file dalam extensi yang lain 

17. Untuk membuat nomor halaman pada slide digunakan tools …  

1. Text Box   

2. Word  Art 

3. Clip Art 

4. Emphasis 

5. Font  

Jawaban yang tepat adalah.. 

a. 1,2   

b. 1,5   

c. 5 

d. 3,4   

e. 3,5  

18. Berikut ini yang merupakan sub menu dari menu insert adalah.. 

a.  
 

b.  
 

c.  
 

d.  
 

e.  
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19. Kotak dialog ini berfungsi untuk.. 

 
a. Mengatur tujuan hyperlink  

b. Mengatur banyaknya slide 

c. Mengatur animasi yang akan di edit 

d. Membuat animasi baru 

e. Mengatur objek yang bergerak 
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POSTTEST  

MEMBUAT PRESENTASI DENGAN VARIASI TEKS, GAMBAR, 

ANIMASI TRANSISI DAN HYPERLINK 

Kriteria mengerjakan postest :  

1. Berdoalah sebelum mengerjakan tes.  

2. Tulis identitas pada lembar ini dengan jelas.   

3. Baca soal dengan baik dan cermati maksudnya.  

4. Pilih satu jawaban yang paling tepat kemudian beri tanda silang pada huruf a, b, c, atau d.  

5. Telitilah kembali setelah selesai mengerjakan soal sebelum diserahkan untuk dinilai.  

 

SELAMAT MENGERJAKAN 
 

Nama Lengkap  : _____________________________________________ 

Kelas / Presensi  : _____________________________________________ 

1. Untuk memasukkan gambar di dalam slide menggunakan perintah  

a. Insert > Picture 

b. Insert > New Slide  

c. Insert > Clip Art  

d. Insert > Picture > Clip Art 

e. Insert > Object  

2. Shortcut yang digunakan untuk menyalin slide adalah.. 

a. Ctrl + X 

b. Ctrl + C 

c. Ctrl + E 

d. Ctrl + M 

e. Ctrl + V  

 

3. Perintah yang digunakan untuk merubah bentuk, ukuran dan gaya huruf adalah.. 

a. File – Format – Font 

b. Insert – Format – Font 

c. Format – Font 

d. Home – Font  

e. Edit – Format – Font  

4. Perintah yang digunakan untuk merubah layout pada suatu slide adalah.. 

a. Home – Slide 

b. Home – Style Layout  

c. Home – Layout 

d. Home – Design Layout  

e. Home – Slide Layout  

5. Fasilitas layout slide digunakan untuk.. 

a. Animasi layout 

b. Memberi font 

c. Memilih tata letak isi dan content pada slide 

d. Memberi garis bantu  

e. Memberi spasi  

6. Kegunaan dari tombol “Apply” pada kotak dialog format – background adalah.. 

a. Mengaktifkan pilihan pada setiap presentasi  

b. Mengaktifkan pilihan pada presentasi aktif 

c. Mengaktifkan pilihan pada slide sebelumnya 

d. Mengaktifkan pilihan pada slide aktif 

e. Mengaktifkan pilihan pada setiap slide  



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

7. Menu yang tidak terdapat pada Microsoft Power Point 2007 adalah..  

a. Insert 

b. Review 

c. Add – Ins  

d. Home 

e. Mailings 

8. Berikut ini termasuk Custom Animation, kecuali… 

a. Entrance 

b. Emphasis  

c. Exit  

d. Motion Paths  

e. Animation Scheme  

9. Berikut yang termasuk sub menu dari Slide Show adalah… 

a. New Slide 

b. Slide Number 

c. Chart 

d. Diagram  

e. Rehearse Timings  

10. Yang dimaksud dengan animasi secara umum adalah… 

a. Objek (teks atau gambar) yang bergerak 

b. Objek yang dapat menghilang dan muncul kembali  

c. Gambar kartun  

d. Objek lucu 

e. Gambar diam  

11. Tools animasi yang dapat kita gunakan untuk membuat suatu objek lingkaran dan berputar sesuai garis 

orbit tersebut adalah.. 

a. Hexagon 

b. Spiral 

c. Octagon 

d. Circle  

e. Football  

12. Layout di bawah ini disebut… 

 
a. Title slide 

b. Title and Content  

c. Two Content 

d. Content With Caption 

e. Section Header  

13. Ekstensi file berikut yang merupakan ekstensi dari tipe file powerpoint 2007 adalah...  

a. .ppt   

b. .Gif  

c. .pptx  

d. .Doc  

e. .Xls 

14. Perintah slide layout digunakan untuk …  

a. Menampilkan presentasi satu layar penuh  

b. Menampilkan bentuk-bentuk slide  

c. Menampilkan navigasi  

d. Menampilkan add effect  

e. Menampilkan bentuk-bentuk background 
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15. Gambar kotak dialog di bawah digunakan untuk.. 

 
a. Penggabungan Navigasi  

b. Memberikan efek pada huruf  

c. Memberikan efek setelah animasi tertentu selesai   

d. Menggabungkan slide dan navigasi  

e. Menghubungkan slide-slide maupun file dalam extensi yang lain 

16. Untuk membuat nomor halaman pada slide digunakan tools …  

1. Text Box   

2. Word  Art 

3. Clip Art 

4. Emphasis 

5. Font  

Jawaban yang tepat adalah.. 

a. 1,2   

b. 1,5   

c. 5 

d. 3,4   

e. 3,5  

17. Berikut ini yang merupakan sub menu dari menu review adalah.. 

a.  
 

b.  
 

c.  
 

d.  
 

e.  
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18. Ada beberapa komponen presentasi yang dapat diberi animasi, kecuali.. 

a. Teks    

b. Objek Gambar 

c. Transisi Slide 

d. Peralihan Slide  

e. Layout  

19. Menu berikut yang digunakan untuk membuat hyperlink dengan hanya mengarahkan kursor pada media 

hyperlink terletak pada bagian nomor.. 

  
a. 1 

b. 2   

c. 3 

d. 4   

e. 5  

 

1 

2 

3 

5 4 
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Lampiran 11. Data Siswa  



ATTENDENCE LIST 
CLASS XA 

SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

MEETING DATE  

31/3 7/2 21/4 28/4 5/5 INFO  

1 8789 
ADANTYO SATYA GILANG 
MARANDRARTA  M ∙ ∙ ∙ S ∙  

2 8791 ADITYA WIHARNANTO  M ∙ ∙ ∙ ∙ ∙  

3 8799 ANASTASIA DWI ANGGITASARI  F S ∙ A ∙ ∙  

4 8824 BENEDICTUS DAVID PRATAMA  M ∙ ∙ ∙ ∙ ∙  

5 8825 BERNADETTA DIAN RAHAYU F ∙ ∙ ∙ ∙ ∙  

6 8830 CICILIA FITRI MEDIASWATI F ∙ ∙ ∙ ∙ ∙  

7 8831 DAVID YUDHA PRANATHA  M ∙ ∙ ∙ ∙ ∙  

8 8837 DESTI VITRIANI F ∙ ∙ ∙ ∙ ∙  

9 8842 DIMAR MUKTIANA F ∙ ∙ ∙ ∙ ∙  

10 8843 DIONYSIUS RIRIHENA  M ∙ ∙ ∙ ∙ S  

11 8859 FANDI AKHMAD KURNIAWAN  M ∙ ∙ ∙ ∙ ∙  

12 8874 FRANSISCA APRILIA TRI UTAMI  F ∙ ∙ ∙ ∙ ∙  

13 8877 GALIH KARTIKA ADE SAPUTRA  M ∙ ∙ ∙ ∙ ∙  

14 8886 HANA UMI PERTIWI  F ∙ ∙ ∙ ∙ ∙  

15 8892 HENI KRISTIANINGTYAS  F ∙ ∙ ∙ ∙ ∙  

16 8896 IFFAH NUR ARDHIYANI F ∙ ∙ ∙ ∙ ∙  

17 8910 IRMA ALFIA ROSYIDA F ∙ ∙ ∙ ∙ ∙  

18 8912 IVANA SRI RAHAYU F ∙ ∙ ∙ ∙ ∙  

19 8933 NADIA RACHMA PUSPITA F ∙ ∙ ∙ ∙ ∙  

20 8939 NOVALITA ULFAH NUR UBAY F ∙ ∙ ∙ ∙ ∙  

21 8941 NUR FAJRIYAH ROSYIDAH  F ∙ ∙ ∙ ∙ ∙  

22 8958 REINARDUS GADING PRADANA  M ∙ ∙ ∙ ∙ ∙  

23 8961 REZA NUR RAHMAN  M ∙ ∙ ∙ ∙ ∙  

24 8981 SHELLA CHINTYA DIAN FIRERA  F ∙ ∙ ∙ ∙ ∙  

25 8984 SKOLASTIKA TYAS ANGGRAINI F ∙ S ∙ ∙ ∙  

26 8985 SPIRIDONA ADVENTIA CHRISTYANTI  F ∙ ∙ ∙ ∙ ∙  

27 8989 THERESIA ERNI PRASTITI F ∙ ∙ ∙ ∙ ∙  

28 8992 TYAS ARI WIBAWA  M ∙ ∙ ∙ ∙ ∙  

29 8995  ULFI ARIANA INDAH SARI  F ∙ ∙ ∙ ∙ ∙  

30 8998 VINCENTIUS EKO CAHYANTO  M ∙ ∙ ∙ ∙ ∙  

31 9000 WAHIB KURNIAWAN  M ∙ ∙ ∙ ∙ ∙  

32 9003 YASINTA MAURA IEKA PURNAMA  F ∙ ∙ ∙ ∙ ∙  

   

 
L : 12 
P : 20  
 

 
∙ 

     

Menyetujui, 
Guru Pembimbing 

 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 

 



ATTENDENCE LIST 
CLASS XB 

SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

MEETING DATE  

31/3 7/4 21/4 28/4  INFO  

1 8790 ADITA WIDHANTARA M ∙ ∙ A ∙   

2 8792 ADNAN SINTAN RIFAI  M ∙ ∙ ∙ ∙   

3 8793 AHMAD NUGROHO MEI HERWANTO  M ∙ ∙ ∙ ∙   

4 8812 ARDINA MAFTUHATUN NIKMAH F ∙ ∙ ∙ ∙   

5 8814 ARNI MAULIDYA FAHIMA F ∙ ∙ ∙ ∙   

6 8819 AYU ISTI PRABANDARI F ∙ ∙ ∙ ∙   

7 8826 BIMO ANANTYO  M ∙ ∙ ∙ ∙   

8 8828 BUDI SATRIYO  M ∙ ∙ ∙ ∙   

9 8835 DESI NUGROHANINGRUM  F ∙ ∙ ∙ ∙   

10 8839 DEVI KUSUMASTUTI  F ∙ ∙ ∙ ∙   

11 8844 DUTA SAYOGA  M ∙ S A ∙   

12 8861 FANINA FADHILAH PUTRI AGLIS  F ∙ ∙ ∙ ∙   

13 8869 FEBRIZA AULIA SYARIATI F ∙ ∙ ∙ ∙   

14 8872 FIKRI FACHRY HIDAYAT M ∙ ∙ ∙ ∙   

15 8882 GILAR MENTARI F ∙ I  ∙ ∙   

16 8884 GUSTOMI ALFIANDRI  M I ∙ ∙ I   

17 8902 INDAH KURNIAWATI F ∙ I ∙ ∙   

18 8908 IRA MUSARAFA  F ∙ ∙ ∙ ∙   

19 8913 JANUAR RISALDI  M I  I ∙ I   

20 8925 MEILANA AYU PUTRI DINI F ∙ ∙ ∙ ∙   

21 8932 NADIA AGATHA PRAMESTHI F ∙ ∙ ∙ ∙   

22 8936 NASIEMATUL ARIFAT F I  ∙ ∙ I   

23 8943 NURUL FITRI ASTUTI  F ∙ ∙ ∙ ∙   

24 8950 QANA’ATUSY SYARIFAH  F ∙ ∙ ∙ ∙   

25 8957 RAVILIONA TIARA YULIANTIKA F ∙ ∙ ∙ ∙   

26 8959 RENY EKA SETIYOWATI F ∙ I ∙ ∙   

27 8964 RIFAN PRANANCA BAGUS SAPUTRA M ∙ ∙ ∙ ∙   

28 8982 SHINTA WAHYU SAPUTRI  F ∙ ∙ ∙ ∙   

29 8996 UNTARI RAHMAWATI F ∙ ∙ S ∙   

30 8999 VISTA AYUNINGTYAS  F ∙ ∙ ∙ ∙   

31 9007 YOHANES WAHYU KENDY PRATAMA M ∙ I ∙ ∙   

32 9008 
YONATAN WISNU KENDY 
PRASETYO  M ∙ I ∙ ∙   

   

 
L : 12 
P : 20  
 

 
∙ 

     

Menyetujui, 
Guru Pembimbing 

 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 
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Lampiran 12. Data Hasil Penelitian  



CLASS XA 
SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

NILAI 

Pretest  
 

Posttest  Keaktifan  

1 8789 
ADANTYO SATYA GILANG 
MARANDRARTA  M 63  79 ** 

2 8791 ADITYA WIHARNANTO  M 79  79 ***** 

3 8799 ANASTASIA DWI ANGGITASARI  F 63  89 * 

4 8824 BENEDICTUS DAVID PRATAMA  M 58  79 ** 

5 8825 BERNADETTA DIAN RAHAYU F 68  75 * 

6 8830 CICILIA FITRI MEDIASWATI F 74  79 * 

7 8831 DAVID YUDHA PRANATHA  M 63  84 * 

8 8837 DESTI VITRIANI F 58  95 *** 

9 8842 DIMAR MUKTIANA F 74  100 ** 

10 8843 DIONYSIUS RIRIHENA  M 63  79 ** 

11 8859 FANDI AKHMAD KURNIAWAN  M 79  89 * 

12 8874 FRANSISCA APRILIA TRI UTAMI  F 74  89 * 

13 8877 GALIH KARTIKA ADE SAPUTRA  M 79  89 * 

14 8886 HANA UMI PERTIWI  F 58  84  

15 8892 HENI KRISTIANINGTYAS  F 68  79  

16 8896 IFFAH NUR ARDHIYANI F 47  100 * 

17 8910 IRMA ALFIA ROSYIDA F 63  95 * 

18 8912 IVANA SRI RAHAYU F 74  89 ** 

19 8933 NADIA RACHMA PUSPITA F 74  100  

20 8939 NOVALITA ULFAH NUR UBAY F 47  100  

21 8941 NUR FAJRIYAH ROSYIDAH  F 63  95 * 

22 8958 REINARDUS GADING PRADANA  M 79  84  

23 8961 REZA NUR RAHMAN  M 68  84 ** 

24 8981 SHELLA CHINTYA DIAN FIRERA  F 79  89 * 

25 8984 SKOLASTIKA TYAS ANGGRAINI F 74  84  

26 8985 SPIRIDONA ADVENTIA CHRISTYANTI  F 68  89 ** 

27 8989 THERESIA ERNI PRASTITI F 47  84  

28 8992 TYAS ARI WIBAWA  M 68  75 * 

29 8995  ULFI ARIANA INDAH SARI  F 74  79 ** 

30 8998 VINCENTIUS EKO CAHYANTO  M 68  89  

31 9000 WAHIB KURNIAWAN  M 63  79  

32 9003 YASINTA MAURA IEKA PURNAMA  F 68  75  

 

    
  

 
Total  2755 L : 12 

  
     

 
Rata – rata  86.09 P : 20 

  
     

 
     

     

Menyetujui, 
Guru Pembimbing 

 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 

 



CLASS XB 
SMA NEGERI 1 KALASAN  

ACADEMIC YEAR 2011/2012 (SEMESTER II)  

 

NUM NIS  NAME M / F  

MEETING DATE  

Pretest  
 

Posttest Keaktifan  

1 8790 ADITA WIDHANTARA M 79  74 * 

2 8792 ADNAN SINTAN RIFAI  M 47  84 *** 

3 8793 AHMAD NUGROHO MEI HERWANTO  M 63  63 * 

4 8812 ARDINA MAFTUHATUN NIKMAH F 58  74 ** 

5 8814 ARNI MAULIDYA FAHIMA F 53  79 *** 

6 8819 AYU ISTI PRABANDARI F 68  74 * 

7 8826 BIMO ANANTYO  M 53  63  

8 8828 BUDI SATRIYO  M 84  79  

9 8835 DESI NUGROHANINGRUM  F 68  89  

10 8839 DEVI KUSUMASTUTI  F 74  84 * 

11 8844 DUTA SAYOGA  M 74  84  

12 8861 FANINA FADHILAH PUTRI AGLIS  F 68  79  

13 8869 FEBRIZA AULIA SYARIATI F 53  84  

14 8872 FIKRI FACHRY HIDAYAT M 68  74  

15 8882 GILAR MENTARI F 68  74  

16 8884 GUSTOMI ALFIANDRI  M 

 
   

17 8902 INDAH KURNIAWATI F 84  74  

18 8908 IRA MUSARAFA  F 74  84  

19 8913 JANUAR RISALDI  M 

 
   

20 8925 MEILANA AYU PUTRI DINI F 79  84  

21 8932 NADIA AGATHA PRAMESTHI F 84  100  

22 8936 NASIEMATUL ARIFAT F 

 
   

23 8943 NURUL FITRI ASTUTI  F 79  84  

24 8950 QANA’ATUSY SYARIFAH  F 47  89  

25 8957 RAVILIONA TIARA YULIANTIKA F 89  79  

26 8959 RENY EKA SETIYOWATI F 68  68 ** 

27 8964 RIFAN PRANANCA BAGUS SAPUTRA M 74  89  

28 8982 SHINTA WAHYU SAPUTRI  F 32  79  

29 8996 UNTARI RAHMAWATI F 74  95 ** 

30 8999 VISTA AYUNINGTYAS  F 53  89  

31 9007 YOHANES WAHYU KENDY PRATAMA M 63  89 * 

32 9008 
YONATAN WISNU KENDY 
PRASETYO  M 74  74  

 

    
  

 
Total  2330 L : 12 

  
     

 
Rata – rata  80.34 P : 20 

  
     

      

     

      

     

Menyetujui, 

Guru Pembimbing 
 
 
 

Arief Budiman, S.Pd.  
NIP. 19761123 200501 1 014 

 
Mahasiswa Peneliti, 

 
 
 

Mawar Ramadhani 
NIM. 08520241028 
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Lampiran 13. Surat Keputusan Pembimbing  



KEPUTUSAN DEKAN
FAKULTAS TEKNIK

UNIVERSITAS NEGERI YOGYAKARTA
NOMOR z lztELW Q-l |llzDlt

TENTANG
PENGANGKATAN PEMBIMBING TUGAS AKHIR SKRIPSI

BAGI MAHASISWA FAKULTAS TEKNIK UNIVERSITAS NEGERI YOGYAKARTA

DEKAN FAKULTAS TEKNIK
UNIVERSITAS NEGERI YOGYAKARTA

Menimbang : l. Bahwa sehubungan dengan telah dipenuhi syarat untuk penulisan Tugas Akhir Skripsi bagi

mahasiswa Fakultas Telnik Universitas Negeri Yogyakarta, perlu diangkat pembimbing'

2. Bahwa untuk keperluan dimaksud perlu ditetapkan dengan Keputusan Dekan.

Mengingat : 1. Undang-undang Nomor 20 tahun 2003.

2. PeraturanPemerintah RI Nomor 60 tahun 1999'

3. Keputusan Presiden RI: a. Nomor 93 tahun 1999;b.305i\4 tahun 1999.

4. Keputusan Menteri Pendidikan dan Kebudayaan RI: Nomor 2741C.11999'

5. Keputusan Mendiknas RlNomor 003/0/2001'

6. Keputusan Rektor UNY Nomor : 1160/UN34lKPl20ll

MEMUTUSKAN
Menetapkan

Mengangkat pembimbing Tugas Akhir Skripsi bagi mahasiswa Fakultas Teknik Universitas Negeri

Yogyakarta sebagai berikut :

Pertama

Nama Pembimbing
Bagi mahasiswa
NamaA{o.Mahasiswa
Jurusan/ Prodi

Dr. Eko Marpanaji

Marnrar Ramadhani I A852A:241028,',
pendidikan Teknik Elektronika / Pendidikan Teknik Informatika

tugas membimbing penulisan Tugas Akhir Skripsi sesuai dengan
Kedua

Ketiga

Keempat

Dosen pembimbing diserahi

Pedoman Tugas Akhir SkriPsi.

Keputusan ini berlaku sejak ditetapkan

Segala sesuatu akan diubah dan dibetulkan sebagaimana mestinya apabila di kemudian hari ternyata

terdapat kekeliruan dalam Keputusan ini.

Ditetapkan : di YogYakarta

Padatanggal ; 10 Januxi2}l2

Soenarto
30 198601 1 001

Tembusan Yth :

1. Pembantu Dekan I, II, [I FT LrNY
2. Ketua Jurusan Pendidikan Teknik Elektronika

3. Ka Bag Tata UsahaFT UNY
4. Yang bersangkutan ''l'i

Ie

ffi
f. N(--r

=it'trx. 116*r*
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Lampiran 14. Surat Izin Penelitian  



KEMENTERIAN PENDIDIKAN DAN KEBUDAYAAN

UNTVERSITAS NEGERI YOGYAKARTA

FAKULTAS TEKNIK
Alamat : Kampus Karangmalang, Yogyakarta, 55281

Telp. (0274) 586'168 psw.276,289,292(0274) 586734 Fax. (0274) 586734
website : http://ft . unv.ac. id e-mail: ft@unv.ac. id ; teknik@uny. ac. id

t7,fit':0t: !: {}/}

letffirs'le Nr. QSC l[tSfl

Nomor : 0075/UN34.l5lPLl20l2
Lamp. : 1(satu)benddl
Hal : Permohonan Ijin Penelitian

17 Januari2}l2

Yth.
1. Gubernur Provinsi DIY c.q. Ka. Biro Administrasi Pembangunan Setda Provinsi DIY
2. Bupati Sleman c.q. Kepala Bappeda Kabupaten Sleman

3,. Kepala Dinas Pendidikan, Pemuda dan Olakaga Propinsi DIY
4. Kepala Dinas Pendidikan Kabupaten Sleman

5. Kepala SMANEGEzu 1 KALASAN

Dalam rangka pelaksanaan Tugas Akhir Skripsi kami mohon dengan hormat bantuan Saudara

memberikan rjin untuk melaksanakan penelitian dengan judul "EFEKTMTAS
PENGGUNAAN MEDIA PEMBELAJARAN E.LEARNING BERBASIS WEB BASED

TRAINING TERIIADAP HASIL BELAJAR SISWA MATA PELAJARAN TEKNOLOGI
INFORMASI DAN KOMUNIKASI KELAS X SMA NEGERI 1 KALASAN", bagi

mahasiswa Fakultas Teknik Universitas Negeri Yogyakarta tersebut di bawah ini:

No. Nama NIM Jurusan/?rodi Lokasi Penelitian

1 Mawar Ramadhani 0852024r028 Pend. Teknik Informatika -

S1

SMA NEGERI 1

KALASAN

Dosen Pembimbing/Dosen Pengampu : Dr. Eko Marpanaji
NIP : 19670608 199303 1 001

Adapun pelaksanaan penelitian dilakukan mulai tanggal 17 Januari 2012 sampai dengan selesai.

Demikian permohonan ini, atas bantuan dan kerjasama yang baik selama ini, kami mengucapkan

terima kasih.

Tembusan:
Ketua Jurusan
Ketua Program Studi

Dekan,
u.b. Wakil Dekan I,

ffiR
*i{{;HH}s)e

0852024'1028 No.40



PEMERINTAH PROVINSI DAERAH ISTIMEWA YOGYAKARTA
SEKRETARIAT DAERAH

Kompleks Kepatihan, Danurejan, Telepon (0274) 562811 - 562814 (Hunting)
YOGYAKARTA 55213

SURAT KETERANGAN / IJIN
070t3704Nt4t2012

Membaca Surat : Dekan Fak. Teknik UNY

Tanggal : 17 Januari2012

Nomor : 0075/UN34.15lPLl2012

Perihal : ljin Penelitian

NIP/NIM : 08520241028

Mengingat ;1. Peraturan Pemerintah Nomor 41 Tahun 2006, tentang Perizinan bagi Perguruan Tinggi Asing,
Lembaga Penelitian dan Pengembangan Asing, Badan Usaha Asing dan Orang Asing dalam
melakukan Kegitan Penelitian dan Pengembangan di lndonesia;

2. Peraturan Menteri Dalam Negeri Nomor 33 Tahun 2007, tentang Pedoman penyelenggaraan
Penelitian dan Pengembangan di Lingkungan Departemen Dalam Negeri dan Pemerintah Daerah;

3. Peraturan Gubernur Daerah lstimewa Yogyakarta Nomor 37 Tahun 2008, tentang Rincian Tugas dan
Fungsi Satuan Organisasi di Lingkungan Sekretariat Daerah dan Sekretariat Dewan Perwakilan
Rakyat Daerah.

4. Peraturan Gubernur Daerah lstimewa Yogyakarta Nomor 1B Tahun 2009 tentang Pedoman Pelayanan

Perizinan, Rekomendasi Pelaksanaan Survei, Penelitian, Pendataan, Pengembangan, Pengkajian,

dan Studi Lapangan di Daerah lstimewa Yogyakarta.

DIIJINKAN untuk melakukan kegiatan survei/penelitian/pendataan/pengembangan/pengkajian/studi lapangan kepada:

Nam'a

Alamat
Judul

Lokasi

Waktu

MAWAR RAMADHANI

Karangmalang Yogyakarta

EFEKTIVITAS PENGGUNAAN MEDIA PEMBELAJARAN E.LEARNING BERBASIS WEB

BASED TRAINING TERHADAP HASIL BELAJAR SISWA MATA PELAJARAN

TEKNOLOGI INFORMASI DAN KOMUNTKASI KELAS X SMA NEGERI 1 KALASAN

- Kota/Kab. SLEMAN

17 April 2012 sld 17 Juli 2012

Dengan Ketentuan

1. Menyerahkan surat keterangan/ijin survei/penelitian/pendataan/pengembanganipengkajian/studi lapangan .) dari
Pemerintah Provinsi DIY kepada Bupati/Walikota melalui institusi yang berwenang mengeluarkan ijin dimaksud;

2. Menyerahkan soft copy hasil penelitiannya baik kepada Gubernur Daerah lstimewa Yogyakarta melalui Biro
Administrasi Pembangunan Setda Provinsi DIY dalam compact disk (CD) maupun mengunggah (upload) melalui
website adbang.jogjaprov.go.id dan menunjukkan cetakan asli yang sudah disahkan dan dibubuhi cap institusi;

3. ljin ini hanya dipergunakan untuk keperluan ilmiah, dan pemegang ijin wajib mentaati ketentuan yang berlaku di
lokasikegiatan;

4. ljin penelitian dapat diperpanjang maksimal 2 (dua) kali dengan menunjukkan surat ini kembali sebelum berakhir
waktunya setelah mengajukan perpanjangan melalui website adbang.jogjaprov.go.id;

5. ljin yang diberikan dapat dibatalkan sewaktu-waktu apabila pemegang ijin ini tidak memenuhi ketentuan yang
berlaku.

Dikeluarkan di Yogyakarta

Pada tanggal 17 April2012
A.n Sekretaris Daerah

Asisten Perekonomian dan Pembangunan

ub.

ffi
ii Blts-

,8 *r.P\1. Kepala Biro Ad ministrasi Pemban gunan

t &//tuilO
fl*'
ii ol

Tembusan : il A:JJ
1. Yth. Gub-ernur Daerah lstimewa Yogyakarta (sebagai laporan); o\. @$tl6ZO226 198803 1 0OB

2. BupatiSleman c/q Bappeda

3. Ka. Dinas Pendidikan, Pemuda dan Olahraga Provinsi DIY

4. Dekan Fak. Teknik UNY



PEMERINTAH KABUPATEN SLEMAN

BADAN PERENCANAAN PEMBANGUNAN DAERAH
( BAPPEDA )

Alamat : Jl. Parasamya No. 1 Beran, Tridadi, Sleman 5551 1

Telp. & Fax. (0274) 868800. E-mail :bappeda@slemankab.go'id

Dasar :

Menunjuk :

SURAT IZIN
Nomor : 07.0 / Bappeda/ 1266 I 2012

TENTANG
PENELITIAN

KEPALA BADAI\ PERENCANAAN PEMBANGUNAN DAERAH

Keputusan Bupati Sleman Nomor: 55 /Kep.KDH/N2003 tentang Izin Kuliah Kerja
Nyata, Praktek Kerja Lapangan dan Penelitian.
Surat dari Sekretariat Daerah Pemerintah Provinsi Daerah Istimewa Yogyakarta Nomor:
070/3704N14/2012. Tanggal: l7 April 2012. Hal: Izin Penelitian.

Kepada

Nama
No. MhsA.IIMAilPAIIK
Program/ Tingkat
Instansi/ Perguruan Tinggi
Alamat Instansi/ Perguruan Tinggi
Alamat Rumah
No. Telp/ Hp
Untuk

Lokasi
Waktu

Tembusan Kepada Yth :

1. Bupati Sleman (sebagai laporan)
2. Ka. Kantor Kesatuan Bangsa Kab. Sleman
3. Ka. Dinas Pendidikan, Peumda & OR Kab. Sleman
4. Ka. Bid. Sosbud Bappeda Kab. Sleman
5. Camat Kec. Kalasan
6. Dekan Fak. Teknik-UNY.
7. Ka. SMA Negeri I Kalasan
8. Pertinggal

MENGIZINKAN:

MAWAR RAMADHANI
08520241028
S1

UNY
Karangmalang, Yogyakarta
Kadisoro RT 02 Gilangharjo, Pandak, Bantul, Yogyakarta
0818 0264 3708
Mengadakan penelitian dengan j udul:
(EF'EKTIVITAS PENGGUNAAI\ MEDIA PEMBELAJARAN
E.LEARNING BERBASIS WEB BASED TRAINING
TERIIADAP HASIL BELAJAR SISWA MATA PELAJARAN
TBKNOLOGI INFORMASI DAN KOMTJNIKASI KELAS X
SMA NEGERI 1 KALASAN"
Kab. Sleman
Selama 3 (tiga) bulan mulai tanggalz 17 April 2012 s/d
17 Juli 2012

Dengan ketentuan sebagai berikut :

l. Wajib melapor diri kepada Pejabat Pemerintah setempat (Camat/ Kepala Desa) atau Kepala Instansi
untuk mendapat petunjuk seperlunya.

2. Wajib menjaga tata tertib dan mentaati ketentuan-ketentuan setempat yang berlaku.
3. Izin ini dapat dibatalkan sewahu-wahu apabila tidak dipenuhi ketentuan-ketentuan di atas.

4. Wajib menyampaikan laporan hasil penelitian berupa 1 (satu) CD format PDF kepada Bupati diserahkan
melalui Kepala Bappeda.

5. Izin tidak disalaltgunakan untuk kepentingan-kepentingan di luar yang direkomendasikan.

Demikian izin ini dikeluarkan untuk digunakan sebagaimana mestinya, diharapkan pejabat pemerintah/

non pemerintah setempat memberikan banfuan seperlunya.
Setelah selesai pelaksanaan penelitian Saudara wajib menyampaikan laporan kepada kami I (satu) bulan

setelah berakhimya penelitian.
Dikeluarkan di : Sleman
Pada Taneeal : 17 April2012

A.n. Kepala BAPPBDA Kab. Sleman
Ka. Bidang Pengendaliaa $ f,'valr'rsi

u.b.
Ka. Sub Bid. Litbang

SRI NURHIDAYAH. S.Si. MT
Penafa Tk I TTI/d
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Lampiran 15. Surat Keterangan Selesai Penelitian  



v'- - .-

i
I

I

F:*\

PEMERINTAH KABUPATEN SLEMAN
DINAS PENDIDIKAN, PEMUDA DAN OLAHRAGA

SMA NEGERI I KALASAN
Alamat

Email
Website

: Bogem, Tamanmartani, Kalasan, Sleman 55571
Telp. (027 4 ) 496040, Fax.: (027 4)496040

: www.sman I kalasan.sch.id

SURAT KETERANSAI{
Nomor : 070/ 391

Yang bertanda tangan dibawah ini Kepala Sekolah Menengah Atas Negeri I Kalasan

Kabupaten Sleman menerangkan dengan sesungguhnya bahwa Mahasiswa Universitas

negeri Yogyakarta G[NY) tersebut di bawah ini :

Nama

NIM
Fakultas

Prodi

Jurusan

Program/Tingkat

Alamat

MAWAR RAMADHANI

08520241028

Teknik

Pendidikan Teknik Informatika

Pendidikan Teknik Elektronika

Sarjana (Sl)

Kadisoro RT 02 Gilangharjo pandak Bantul

Telah melaksanakan kegiatan penelitian dengan judul " EFEKTIVITAS PENGGUNAAN
MEDIA PEMBELAJARAN E.LEARNING BERBASIS WEB BASED TRAINTNG
TERHADAP HASIL BELAJAR STSWA MATA PELAJARAN TEKNOLOGI
INFORMASI DAN KOMI.INIKASI KELAS X SMA NEGERI I KALASAN,, pada

tanggal l8 Februari 2012 s.d 5 Mei 2012.

Demkian surat keterangan ini kami buat, untuk digunakan sebagaimana mestinya.

ll Juni 2012
h,

SUGIHARTO

=
H,ffi

//*\6*.il
i o_ [EllAt{Ecrn\\*F\\.N

198103 t 024
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Lampiran 16. Labsheet  



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

LABSHEET 1 

SIMULASI ELEKTRON 
MATERI  

 MICROSOFT OFFICE POWER POINT 2007  

POKOK BAHASAN  

 ANIMASI MENGGUNAKAN MICROSOFT OFFICE POWER POINT 2007  

TUJUAN PEMBELAJARAN 

Setelah proses pembelajaran materi ini, peserta didik diharapkan mampu :  

1. Membuat animasi dalam presentasi menggunakan powerpoint 2007.  

LANGKAH – LANGKAH PEMBUATAN (ANIMASI SIMULASI ELEKTRON)  

1. Buka Power Point 2007 

 
2. Buat 3 lingkaran untuk dijadikan perumpamaan electron, proton dan inti atom.  

 
3. Beri animasi pada setiap lingkaran. Lingkaran 1, 2 dengan animasi motion paths – circle 

dan lingkaran 3 dengan emphasis – spin.  
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4. Atur effect seperti ini untuk setiap lingkaran.  

 
 

5. Sesuaikan desain simulasi sehingga menyerupai posisi electron.  

 

 

6. Mainkan.  

 TUGAS  

BUATLAH PRESENTASI ANIMASI SIMULASI ELEKTRON, DENGAN MENGIKUTI LANGKAH – LANGKAH 

YANG SUDAH TERTERA DI ATAS, KEMUDIAN UPLOAD MENGGUNAKAN E-LEARNING.  

SELAMAT MENGERJAKAN!  
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LABSHEET 2 

ANIMASI TRANSISI SEDERHANA 
MATERI  

 MICROSOFT OFFICE POWER POINT 2007  

POKOK BAHASAN  

 ANIMASI MENGGUNAKAN MICROSOFT OFFICE POWER POINT 2007  

TUJUAN PEMBELAJARAN 

1. Membuat animasi dalam presentasi menggunakan powerpoint 2007, terutama dalam 

kompetensi animasi transisi  

LANGKAH – LANGKAH PEMBUATAN (CONTOH ANIMASI TRANSISI SEDERHANA)  

1. Buka Power Point 2007 

 
 

2. Buat 3 slide kosong dengan layout 1(Title Slide) 2(Title and Content) 3(Two Content). 

Jangan lupa beri background bebas, dan sisipkan halaman slide.  

   
 

3. Pasang transisi pada masing – masing slide, dengan cara klik menu “Animations” – 

“Transition to This Slide”. Silakan pilih bebas.  

 
 

4. Ketikkan teks nama lengkap, kelas dan presensi pada slide 1. Kemudian beri animasi 

Entrance – Flip.  
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Contoh slide seperti ini  

 
 

5. Untuk slide 2, perhatikan keterangan di bawah ini.  

Judul 

 > Tipe : entrance, otomatis jalan  

 > Jenis : basic, perhuruf  

Isi  

 > Tipe : entrance, otomatis jalan  

 > Jenis : bebas  

 > Setelah animasi selesai : berubah warna  

Judul dan Isi :  

 > Tipe : exit otomatis lalu berganti slide  

 

Contoh slide seperti ini  

  
Isi teks bebas. 

 

6. Untuk slide 3, buatlah animasi gambar seperti contoh. Perhatikan contoh!  

Judul  

 Emphasis – Brush on Color  

Isi (Teks)  

 Emphasis – Teeter  

Isi (Gambar)  

 Animasi bebas  

 

Atur sedemikian rupa sehingga animasi teks dan gambar yang sama muncul bergantian.  
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Contoh slide seperti ini  

  
Isi gambar seputar binatang.  

 

 

SELAMAT MENCOBA!!! 
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LABSHEET 3 

HYPERLINK DALAM PRESENTASI POWER POINT 
MATERI  

 MICROSOFT OFFICE POWER POINT 2007  

POKOK BAHASAN  

 HYPERLINK DALAM MICROSOFT OFFICE POWER POINT 2007  

TUJUAN PEMBELAJARAN  

 Membuat animasi dalam presentasi menggunakan powerpoint 2007, terutama dalam 

kompetensi hyperlink   

 

TEORI  

Membuat hyperlink  

Anda dapat membuat hyperlink yang akan mengantarkan tampilan ke slide – slide selanjutnya 

ataupun slide secara acak. Anda dapat membuat link dari berbagai macam objek, termasuk teks, 

shape, tabel, paragraf dan gambar.  

 

Anda juga dapat membuat link pada beberapa file, di antaranya : 

 Membuat hyperlink ke halaman Web  

Membuat alamat link menuju situs Web sebuah perusahaan sering menjadi salah satu 

pilihan presenter, sehingga audiensi dapat langsung melihat kegiatan, produk, dan fasilitas 

– fasilitas yang dimiliki perusahaan tersebut. Untuk membuat hyperlink ke situs Web 

lakukan langkah berikut :  

1. Tampilkan slide dalam keadaan Normal View, misalnya pilih teks yang berisi alamat 

situs Web. 

2. Lanjutkan dengan memilih tab Insert kemudian klik Hyperlink, atau tekan Ctrl + K 

untuk shortcutnya.  

3. Akan muncul kotak dialog Insert Hyperlink. Pilih menu Exist file or Web Page, 

kemudian pada kotak Address isi alamat situs Web, misalnya http://www.detik.com. 

Setelah pengaturan selesai, klik OK untuk mengakhiri. 

  
4. Setelah selesai melakukan langkah tersebut, cobalah tampilkan slide pada posisi Full 

Screen dengan klik F5.  

 

 Membuat hyperlink ke file baru 

Untuk membuat hyperlink dari presentasi file baru lakukan langkah sebagai berikut :  

1. Pastikan Anda membuat antarmuka dalam keadaan Normal View, kemudian pilih 

teks atau objek yang ingin Anda gunakan sebagai hyperlink.  

2. Pada tab Insert klik Hyperlink. Untuk shortcut perintah ini, anda dapat menekan 

Ctrl + K pada keyboard.  

http://www.detik.com/
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3. Akan tampil kotak dialog Insert Hyperlink, kemudian pilih Create New 

Document, seperti gambar berikut :  

 
4. Beri alamat yang akan Anda link ke kotak dialog Name of new document. Secara 

default Full Path berada pada lokasi di mana Anda menempatkan file. Jika ingin 

membuat dokumen pada lokasi lain, di bawah Full Path klik Change, cari lokasi 

yang Anda inginkan untuk membuat file baru, kemudian klik OK.  

5. Setelah mengedit lokasi Full Path pada kotak dialog Insert Hyperlink, tentukan 

apakah Anda akan melakukan pengeditan untuk slide baru saat itu juga atau nanti, 

pilih opsi di bawah When to edit kemudian klik OK.  

6. Untuk mengetahui hasil dari langkah tersebut tekan F5 pada keyboard dan Anda 

akan memperoleh tampilan Full Screen.  

 
 

Menghapus hyperlink  

Jika hyperlink sudah tidak dibutuhkan lagi, Anda dapat menghapusnya dengan langkah sebagai 

berikut :  

1. Dalam keadaan Normal View pilih teks atau objek yang menjadi objek hyperlink.  

2. Pilih tab Insert pada grup Links, kemudian klik Hyperlink, atau klik Ctrl + K pada 

keyboard untuk mendapatkan langkah cepat.  

3. Akan tampil kotak dialog Edit Hyperlink untuk menghapus link, kemudian tuliskan alamat 

yang akan dihapus pada kotak Text to display, E-mail address, dan Recently used e-

mail addresses.  

4. Klik Remove Link kemudian klik OK untuk mengakhiri.  
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Action Button 

Action Button terdiri atas beberapa bentuk, seperti anak panah ke kanan dan ke kiri. Sering pula 

tombol ini digunakan untuk simbol yang dipahami sebagai next, previous, first, dan last slides. 

Untuk menggunakan Action Button ikuti langkah sebagai berikut :  

1. Buka slide presentasi dalam keadaan Normal View.  

 
2. Pada tab Insert dalam grup Illustrations klik anak panah di bawahnya kemudian klik 

Shapes, maka akan muncul pilihan shape.  



TIK KELAS X [MAWAR RAMADHANI – INFORMATIKA – UNY  ] 

 
 

3. Dalam menu pilihan shape pada kolom Action Button, klik ikon Home (gambar rumah) 

untuk disisipkan pada slide presentasi, drag ikon tersebut ke dalam slide karena akan 

digunakan sebagai tombol navigasi.  

 
4. Pada slide akan tampil kotak dialog Action Settings.  

  
5. Dalam kotak dialog Action Settings pilih menu Mouse Click sehingga akan tampil 

beberapa menu. Pilih pada Hyperlink to dan dalam kolom di bawahnya pilih First Slide 

(sebagai contoh).  

6. Akhiri dengan meng-klik OK.  

 

TUGAS ! 
 

Bagaimana memberikan perintah Hyperlink hanya dengan mengarahkan kursor ke Media 

Hyperlink tersebut tanpa meng-kliknya?  

Dalam Power Point terdapat fasilitas yang dinamakan Action - Mouse Over. Fasilitas ini dapat diilustrasikan 
seperti ini: kita sedang mempresentasikan sebuah materi di depan umum, anggap saja kita slide show pada 
slide 1 dan kemudian kita ingin memperlihatkan materi yang terdapat di slide 5 maka hanya dengan 
mengarahkan mouse ke media hyperlink (penghubung antara slide 1 dengan slide 5) maka secara cepat slide 
5 ditampilkan. 

Untuk memanfaatkan fasilitas Action - Mouse Over (Hyperlink Tanpa Click), maupun Action – 

Click, ikuti langkah-langkah berikut ini : 

1. Buka PowerPoint, pada slide 1 buatlah Media Hyperlink yang berupa tulisan (bisa juga 

media berupa gambar). Pada contoh dibuat 3 Media Hyperlink (Input, Proses, Output).  

 (Menggunakan Action – Click)  
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2. Pada masing – masing Media Hyperlink buatlah link ke suatu slide yang berhubungan 

dengan tulisan tersebut. Contoh :  

 (Menggunakan Action – Mouse Over) 

Slide arahan dari media hyperlink Input 

 

  
Slide arahan dari media hyperlink Proses 

 

 (Menggunakan Action – Mouse Over) 

Slide arahan dari media hyperlink Output 

 

3. Dari masing – masing slide tujuan, buat lagi hyperlink Action – Mouse Over untuk ketiga 

komponen tersebut.  

4. Tambahkan slide baru sampai minimal 7 buah slide.  

5. Untuk membuat Action – Mouse Over, caranya :  

a. Blok tulisan sebagai media hyperlink 
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b. Pilih sub menu Action pada menu Insert. 

 
c. Klik Action, maka akan muncul kotak dialog Action Settings. Pilih tab Mouse Over dan 

lakukan setting seperti di bawah ini.  

 
d. Lakukan pada semua teks seperti dalam presentasi yang ditampilkan. Jika sudah selesai 

pada kotak dialog Action Settings, akhiri dengan klik OK.  

e. Coba jalankan dengan menekan F5.  

Nb : Teks yang sudah diberikan hyperlink akan memiliki tanda teks berwarna biru dan bergaris 

bawah.  

SELAMAT MENCOBA!!! 
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Lampiran 17. Capture E-Learning SMA Negeri 1 Kalasan  



CAPTURE E-LEARNING SMA NEGERI 1 KALASAN 
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